
Abschlußbericht CAE-Labor WS2003/4     Röhrenverstärker Teil 1                  ORCAD-Schaltplaneingabe

Seite 12-1

OrCAD Capture – Das Werkzeug zur Schaltplaneingabe

Von Daniel Gühne und Andreas Krutz

Allgemein:
OrCAD ist ein komplettes System zur Schaltplan-, Logik- und Layoutentwicklung von elektronischen
Baugruppen. Es besteht aus Modulen zur Schaltplaneingabe und VHDL-Entwicklung, der Simulation
von Schaltkreisen, des Layoutentwurfs komplexer Leiterplatten und der Optimierung jedes einzelnen
Entwicklungsschrittes.

Allgemeiner Aufbau von OrCAD-Capture:
Capture basiert auf einer Windows-Oberfläche, auf der Bauteile aus speziellen Bibliotheken organisiert
und verbunden werden können. Dabei gibt es einige mitgelieferte Bibliotheken (erkennbar an
Dateiendung .OLB), welche um eigene Bibliotheken und Bauteile erweitert werden können. Die
einzelnen Schaltplanseiten lassen sich in Projekten organisieren. Dabei werden von OrCAD-Capture 4
verschiedene Typen von Projekten unterschieden. Einzelne Projekte können als hierarchischer Block in
einem weiteren Projekt ähnlich einem Bauteil eingefügt werden.
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Die Oberfläche:

In der Mitte befindet sich das aktuelle Schaltplanblatt in Vollbilddarstellung. Oben befindet sich ein
Menu, welches teilweise vom gewählten Projekttyp abhängt (hier: Schematic-Typ). Darunter befindet
sich eine Shortcut-Leiste mit diversen Standardfunktionen. Hier (von links nach rechts):
Neue Schaltplanseite, Projekt öffnen, Seite speichern, Seite drucken, Zwischenablage Funktionen
ausschneiden/kopieren/einfügen, Arbeitshistory Schritt zurück/vor, Design Cache der im Design
eingefügten Bauteile, Zoom vergrößern/verkleinern/Region vergrößern/Gesamtübersicht, dann einige
Menushortcuts für die Projekt-Seite (grau unterlegt), Snap to Grid-Funktion, Auruf Projektseite, Aufruf
Knowledge System. Alle diese Shortcuts sind auch über die Menuleiste ganz oben erreichbar.
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Rechts befindet sich die Werkzeugleiste:

Allgemeines Werkzeug. Damit kann man Bauteile, Leitungen etc. verschieben, ggf.
in der Größe ändern oder via Untermenü bearbeiten

Öffnet die Dialog Box „Bauteil hinzufügen“

Zum Zeichnen von Leitungen

Damit kann man einem Netzwerk(Leitung) einen speziellen Namen verpassen und so
z.B. Netzwerke elektrisch verbinden ohne optische Leitung im Schaltplan

Zum Zeichnen von Busstrukturen(Leitungsbündel). Jeder Bus muss einen Namen in
der Form „BusA[0..9]“ (10-Leitungen von 0 bis 9) erhalten

Zum Zeichnen eines Junction-Punktes(Verbindungspunkt)

Zum Zeichnen eines Abzweig einer einzelnen Leitung aus einem Leitungsbündel.
Jede Abzweigung muss einen Namen in der Form „BusA0“ erhalten.

Zum Zeichnen von Versorgungsspannung-Verbindungspunkten

Zum Zeichnen von Versorgungsmasse-Verbindungspunkten

Zum Zeichnen eines Hierarchie-Blocks(Abstraktionsblock eines anderen Schalt-
plans oder Projekts)

Setzen eines I/O Ports(I/O Punkt aus einem aus dem Projekt generierten Hierarchie-
Blocks)

Setzen eines zusätzlichen I/O Ports(Pins) in einem Hierarchie-Block

Setzen eines Off-Page Connector(Übergabepunkt an eine andere Schaltplanseite)

Setzen eines No-Connect-Punktes

Zum Zeichnen einer geraden Linie

Zum Zeichnen eines Vielecks

Zum Zeichnen eines Rechtecks

Zum Zeichnen eines Kreises

Zum Zeichnen eines Halbkreises(1xKlicken-->Zentrum setzen, Aufziehen bis zur
gewünschten Größe, nochmal klicken (Startpunkt), Halbkreis aufziehen)

Zum Schreiben eines Hilfstextes im Schaltplan
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Grundlegende Arbeitsschritte:

Erstellen eines neuen Projekts:

In der Menüleiste den Punkt „File->New->Project“ aufrufen. In der darauffolgenden Dialogbox

einfach den Projektnamen und den Typ sowie den Speicherort wählen und den OK-Button aktivieren.
Projekttypen:
Die ersten 3 sind für spezielle Designziele und Schematic als allgemeines Projekt gedacht.
Erzeugt man ein Analog or Mixed A/D Projekt, so hat man aus OrCAD-Capture direkt Zugriff auf PSpice
zur Simulation der Schaltung.

Bauteil einfügen:
Aktivieren des Buttons „Bauteil hinzufügen“ aus der Werkzeugleiste(siehe oben). In der Dialogbox

lassen sich Bauteilebibliotheken zum Projekt hinzufügen/entfernen, nach einem konkreten Bauteil
suchen, die entsprechende Bibliothek/Bauteil Kombination auswählen und mit dem OK-Button dem
Schaltplan hinzufügen. Danach kann man via Maus und/oder Tastatur das Bauteil plazieren und via
linker Maustaste/Leertaste plazieren. Diese Plazierung lässt sich beliebig oft wiederholen bis man
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entweder im Untermenu(rechte Maustaste) den Endmode aktiviert oder z.B. das Werkzeug wechselt.
Dabei werden die Bauteile von OrCAD automatisch durchnummeriert.

Bauteile via Leitung verbinden:
Werkzeug zum Zeichnen von Leitungen aktivieren. Startpunkt der Leitung (Pin eines Bauteils oder
irgendein anderer Punkt des Schaltplans) anklicken (linke Maustaste), Maus bis zum Endpunkt
bewegen und anklicken. Ist der Endpunkt ein Bauteil-Pin, so endet dort der Draht, sonst kann man die
Leitung gleich weiterziehen bis zum nächsten Punkt.

Masse- und  Versorgungspunkte benutzen:
OrCAD kennt spezielle globale Netze für die Stromversorgung der Bauteile. Diese Masse- bzw.
Versorgungspunkte lassen sich über die entsprechenden Werkzeuge(siehe oben) wie Bauteile
einfügen. OrCAD verbindet gleichbenannte Versorgungspunkte automatisch.

Offpage-Connectoren benutzen:
Um Datenleitungen über Schaltplanblatt-Grenzen hinweg zu verbinden, benötigt man Offpage-
Connectoren. Diese lassen sich über das entsprechende Werkzeug wie ein Bauteil dem
Schaltplanblatt hinzufügen. Dabei gibt es die Möglichkeit die Datenrichtung (uni-/bidirektional)
festzulegen. Alle Offpage-Connectoren gleichen Namens werden von OrCAD je Projekt automatisch
verbunden.

Netznamen/Netz-Aliases anlegen:
Über das entsprechende Werkzeug kann man Leitungen/Datenbusse mit einem Namen verbinden.
Dadurch betrachtet OrCAD Leitungen mit gleichem Netznamen als verbunden. Diese Funktion ist
auch zum Anlegen von Datenbussen notwendig.

Datenbus anlegen:
Dies geschieht über das entsprechende Werkzeug analog zum Ziehen von einzelnen Leitungen.
Jeder Bus muss mit einem Namen in der Form <Name>[0..X], wobei X für die größte Zahl der
Leitungen steht.
Beispiel: ADDR[0..9] für einen Bus ADDR mit 10 Leitungen mit Ordnung 0 bis 9
Zum Herausziehen eines Einzeldrahtes zum Anschluss z.B. an einen Pin eines IC´s, ist ein Busabzweig
notwendig. Dieser wird mit dem entsprechendem Werkzeug gesetzt und muss einen Name der Form
<Name des Busses><Datenleitung>, z.B. ADDR2 für Leitung Nr.2 des Busses ADDR.

Elektrischer Designregel Test des Schaltplans(DRC):
Dazu begibt man sich in das Projektfenster. Dort befindet sich eine Baumstruktur mit den 3
Grundpunkten Design Resources, Outputs und Referenced Projects.
Unter Punkt „Design Resources“ befindet sich die zum Projekt gehörende
Schaltplanblattsammlung(Datei mit Endung .DSN).
Diese muss per einfachem Mausklick ausgewählt werden. Dann kann der DRC über Shortcut-Leiste
oder über Menu aktiviert werden. Es lassen sich das gesamte Projekt auf einmal(Check Entire Design)
oder Teile(Schaltplanseiten) davon testen(Check Selection). Die Test umfassen Verbindungstests der
Offpage-Connectoren, Bezeichnung der Bauelemente, Type der Pins der Bauelemente u.ä..
Trotzdem ist eine gewissenhafte Arbeit des Entwicklers unverzichtbar, da auch ein elektrisch
einwandfreier Schaltplan fehlerhaft arbeiten kann. z.B. wenn ein Relais zu kurze Impulse von der Logik
bekommt, um zu schalten.
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Exportieren des Schaltplans in ein Layout-Programm:
Dazu selektiert man die entsprechende Projekt-Datei im Projekt-Fenster und ruft im Menu „Tools“ den
Menupunkt „Create Netlist“ auf. Der OrCAD eigene Netlist-Typ befindet sich auf dem Karteireiter
„Layout“. Dort muss noch die Angabe zur Masseinheit des Projekts(Inch/Meter) angepasst werden.
Dann kann die Liste mit Aktivierung des OK-Buttons erzeugt werden.

Erzeugen einer neuen Bauteilebibliothek:
Den Menupunkt File->New->Library aktivieren. Im Projektfenster findet sich dann unter Design
Resources eine neue Library. Durch Klick mit der rechten Maustaste auf die Library lässt sich das
Untermenu der Library aufrufen. Dort lassen sich neue Bauteile/Symbole erzeugen oder die Bibliothek
umbennen/abspeichern.

Erzeugen eines neuen Bauteils:
Zuerst muss die Bibliothek, zu der das neue Bauteil hinzugefügt werden soll, erstellt oder geöffnet
werden. Dann kann man den Bauteile-erstellen Dialog über das Untermenu der Bauteilebibliothek
(„New Part“) geöffnet werden.

Unter „Name“ sollte ein aussagekräftiger Name stehen. (z.B. „ECC82 Doppeltriode“)
Der Partprefix ist Teil der Nummerierung der Bauteile, wobei standardmäßig Widerstände ein R,
Kondensatoren ein C, Induktivitäten ein L und IC´s ein U haben. Sollte ein Footprint des Bauteils schon
existieren, kann man es dort verlinken.
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Weiterhin gibt man noch die Anzahl der Symbole pro Bauteil an. Dies kann z.B. für ein AND-Gatter mit
4 Gattern pro IC nützlich sein, für die das Gattersymbol nur einmal gezeichnet wird. Als Angabe unter
„Parts per Pkg“ wird dann „4“ angegeben, womit dann automatisch die benötigten 4 Teilgatter
erzeugt werden. Hierbei wird  zwischen heterogenen und homogenen Bauteilen unterschieden.
Homogene Bauteile bestehen aus mehreren identischen „Parts“, also Teilfunktionalitäten. Heterogene
Bauteile bestehen dagegen aus mehreren unterschiedlichen Teilfunktionalitäten, wie z.B. eine
Doppeltriode, die neben den beiden identischen Triodensystemen auch die Heizung enthält. Die
Teilfunktionen werden durch den sogenannten „Designator“-Buchstaben unterschieden:

A B

Schirm

V400C
E88CC

5

9

4

Heterogenes Bauteil (Doppeltriode)

-

+

U901B
TLC274 CN

5

6
7

4
11

-

+

U901D
TLC274 CN

12

13
14

4
11

Homogenes Bauteil (Operationsverstärker)

V400A
E88CC

3
1

2

-

+

U901C
TLC274 CN

10

9
8

4
11

-

+

U901A
TLC274 CN

3

2
1

4
11

V400B
E88CC

8
6

7

Jetzt hat man ein leeres Blatt vor sich, in das man das Symbol hineinzeichnen kann. Dazu hat man
wieder alle graphischen Werkzeuge, wie im Schaltplan-Editor zur Verfügung. Zusätzlich gibt es
folgende Werkzeuge:

Einfügen eines IEEE-Zeichens

Einfügen eines Pins

Einfügen eines Pin-Ports
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Beim Einfügen eines Pins erscheint folgender Dialog:

Dort gibt man den Namen des Pins(z.B. VCC), die Pin-Nummer(z.B. 14), unter Shape die
Darstellungsform(Linie, Linie mit Invertierungszeichen etc.) und den Typ ein. Weiterhin kann auch
gleich ein Bussanschluss definiert werden. Dann muss die Number wie bei der Definition eines
Datenbusses(siehe oben) erfolgen. Weiterhin kann bei Stromversorgungspins entschieden werden, ob
diese optisch angezeigt werden sollen. Ein OK-Klick ermöglicht das Setzen des Pins auf das
gestrichelt dargestellte Umrandungsrechteck, welches die programmtechnische Grenze des
Bauteilsymbols darstellt. Außer Power-Pins müssen alle Pins einen eindeutigen Namen erhalten.

Über den Menupunkt View->Next Part bzw. View->Previous Part kann man zwischen den einzelnen
Symbolteilen des Bauteils hin- und herschalten(so weit beim Erstellungsdialog angegeben).

Weiterhin kann man die Part-Properties direkt anpassen.

Part-Properties Benutzen/Erstellen:
Part-Properties sind Variablen, welche einen eindeutigen Namen und Wert haben. Diese sind den
Bauteilen zugeordnet und definieren diese in ihren Eigenschaften näher. Es gibt standardisierte Part-
Properties, wie „Part Reference“ für die eindeutige Bezeichnung des Bauteils im Schaltplan, „Color“ für
die Farbe des Bauteils (meist auf Default), „PSpice Template“ als Schnittstelle zu PSpice oder „Value“
für den Nennwert (z.B. 5k bei Widerständen).
Man kann sich zusätzliche Properties definieren. z.B. für die konkrete Bauform oder den Hersteller des
Bauteils. Diese können dann auch z.B. in die Bauteileliste(BOM) übernehmen, um z.B. dem Einkäufer
die Arbeit zu erleichtern.

BOM erzeugen:
Bill Of Materials(BOM) ist die Bauteileliste, welche OrCAD automatische anhand des Projekts oder
eines Schaltplanblattes erzeugen kann. Dabei muss die entsprechende Resource im Projekt-Fenster
auswählen und im Menu Tools->Bill Of Materials aufgerufen werden.
Dort kann man den Header der Tabelle definieren sowie die zu übernehmenden Part-Properties.
Ausserdem kann OrCAD entweder gleiche Bauteile auf einer Zeile zusammenzählen oder jedes
Bauteil auf einer eigenen Zeile in die BOM schreiben. Ein Klick auf OK erzeugt die BOM.

Weiteres zur Arbeitsweise von OrCAD-Capture:
Alle erzeugten Export-Dateien werden im Projekt-Fenster unter dem Punkt Outputs gelistet und sind
dort direkt aufrufbar.
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Allgemeine Design-Regeln zur Erstellung eines Schaltplans:
Der Designer hat die Aufgabe den Schaltplan so übersichtlich wie möglich zu gestalten.
Dazu sollten die Bauteile und Teilschaltungen anhand ihrer Funktion zusammengefasst werden.
Weiterhin sollte das Gesamtprojekt in Teile zerlegt werden, welche jeweils auf ein eigenes
Schaltplanblatt gezeichnet werden. Sinnvoll ist meist eine Zerlegung wie etwa in Netzteil,
Eingabebaugruppe, Signalverarbeitung, Ausgabebaugruppe. Natürlich können die einzelnen
Baugruppen mehrere Seiten umfassen, z.B. bei unserem Röhrenverstärkerprojekt gibt es mehr als eine
Phono-Vorstufe, welche jeweils ein eigenes Schaltplanblatt enthalten. Die Bauteile jedes
Schaltplanblattes sollten einen eigenen Referenznummer-Bereich bekommen (z.B. 100 fürs Netzteil,
200 für die Eingangsbaugruppe usw.), um eine Verwechselung und ein späteres Hinzufügen von
Bauteilen zu erleichtern. Die Verbindungsleitungen zwischen den Schaltplanseiten müssen mit Hilfe
von gleich bezeichneten Off-Page-Connectoren verbunden werden.
Die Bauelemente müssen alle relevanten Informationen, wie Nennwert, Toleranz, Leistung oder
Bauform enthalten. Dabei sollte darauf geachtet werden, nur wirklich relevante Informationen zu
notieren. Es ist z.B. bei Widerständen nicht notwendig die Leistung anzugeben, wenn die notwendige
Leistung unter 0.25W liegt, da alle verfügbaren Widerstände diese Leistung erfüllen.

Hier wurde für den Widerstand R7 eine Belastbarkeit von 1W vorgeschrieben. Weiterhin sind die
Transistoren Q3,Q5,Q6 mit entsprechenden Leistungsangaben für die Dimensionierung der Kühlkörper
versehen. Die Leitungen laufen parallel und kreuzen sich nur an Punkten, wo sie auch verbunden
sind. Die Spannungsversorgung ist als nicht direkt sichtbares Netz ausgelegt, was der Übersichtlichkeit
zu Gute kommt. Das Signal ist eindeutig und verständlich gewählt(12V+ bedeutet eine
Gleichspannung von 12V positiv zur Masse). Der Designer hat für die Masse-Leitungen eine
Sternverkabelung vorgesehen, welche sich im Schaltplan manifestiert. Solche Designregeln für das
Layout, sind vom Designer entweder durch solche speziellen Zeichnungen oder durch schriftliche
Anmerkungen(falls erstere Variante wegen Übersichtlichkeit unsinnig ist) im Schaltplan zu vermerken.
Anmerkungen, wie hier die Leistungsangaben der Transistoren und die Spannungstoleranz der
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Schaltung, werden mit entsprechenden grafischen Elementen(hier: Rahmen) mit dem Ziel
Übersichtlichkeit  hervorgehoben. Weiterhin ist der Typ des Kondensators C1 festgelegt
(Folienkondensator mit 1700V Durchbruchsspannung).


